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ICATS IT CONTEST 2017

JUVENILES (GRADE 7 & 8)

TIME ALLOWED : 90 MINUTES
MAXIMUM MARKS : 90
TOTAL QUESTIONS : 30 MCQS

INSTRUCTIONS

11.
12.

13.

14.

15.

DON'T START ATTEMPTING THE PAPER UNTILINSTRUCTED BY THE INVIGILATORS.
INSTRUCTIONS FROM THE EXAMINATION INVIGILATORS MUST BE CARRIED OUT
PROMPTLY.

WRITE YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS ETC AT THE BUBBLE SHEET
(ANSWER SHEET) ONLY.

RECORD ALL ANSWERS ON THE BUBBLE SHEET ONLY. SELECT BEST ANSWER FROM THE
FOURGIVEN OPTIONS AND MARK ONLY ONE OPTION IN EACH QUESTION.

USE BLUE / BLACK INK TO FILL UP THE CIRCLES FOR YOUR ANSWERS ON THE BUBBLE SHEET.
USE OF LEAD PENCILIS NOT ALLOWED.

USE OF ANY HELPING MATERIAL INCLUDING CELL PHONES AND ELECTRONIC DEVICES IS
STRICTLY PROHIBITED.

EVERY CORRECT ANSWER EARNS THREE POINTS. THERE WOULD BE NEGATIVE MARKING.
ONE POINTWOULD BE DEDUCTED FOR EVERY INCORRECT ANSWER.

CANDIDATES MAY NOT LEAVE THE EXAMINATION ROOM UNESCORTED FOR ANY REASON,
AND THIS INCLUDES USING THE WASHROOM.

NO MATERIALS OR ELECTRONICDEVICES SHALL BEBROUGHT INTO THE ROOM.

. THERE ARE FIVE CATEGORIES OF THE CONTEST AS UNDER:

TODDLERS (GRADE 1 & 2)

KIDS (GRADE3 &4)

JUNIORS (GRADE5 &6)

JUVENILES (GRADE 7 & 8)

ADOLESCENTS (GRADE 9 & 10 / O-LEVELS)

ONLY REGISTERED STUDENTS CAN PARTICIPATE IN THE CONTEST.

NO CANDIDATE SHALL TAKE OUT OF THE HALL ANY ANSWER BOOK(S) OR PART OF AN
ANSWER BOOK, WHETHER USED OR UNUSED, OR OTHER SUPPLIED MATERIAL.

IF A PARTICIPANT DOES NOT UNDERSTAND A WORD OR PHRASE ON THE EXAM PAPER,
NEITHER EXAMINER NOR INVIGILATOR IS PERMITTED TO ANSWER.

FOR INFORMATION ABOUT UPCOMING CONTESTS OR PROVIDING VALUABLE FEEDBACK,
PLEASE VISIT WWW.CATSCONTESTS.ORG

ANY ACADEMIC MISCONDUCT OR MALPRACTICE MUST BE REPORTED TO INTERNATIONAL
CATS CONTESTS AT INFO@CATSCONTESTS.ORG
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3B The processing speed of first generation computers was

ﬂ milliseconds E microseconds ﬂ nanoseconds E picoseconds

X3 Which of the following computer language is used for artificial intelligence?

I FORTRAN 5] ProLOG C I}) cosoL

Which one of the following symbols is used for processing to make a flowchart
of a program

nC 8 () o B/ __/

m Page Layout Formulas Data Review View Developer
‘11 AN EFE= | ¥~ | S Wrap Text| General
- S A~ === i iE Merge&Center - S o

Alignment Number

What will happen to cells I have selected if I press the button circled in orange
in the section of the Ribbon pictured above?

ﬂ Nothing. Pressing this button will give you options to change the orientation of text in your
cell(s).

E The alignment of text in your selected cell(s) will change to match that of the 'ab' pictured on
the button.

[ Your text will change to lowercase letters

2] None of the above options are correct.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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5} study the screenshot below this question. Which shortcut key combinations
would you use to quickly select the column or the row that the selected cell

(E11) is situated in?

o

Insert

G:j !“ Arial - 10

P;!St! =
S B I U-~-| -
Clipboard & Font
Ell .
A B c

7 02-Jan Jan

8 03-Jan Jan

9 04-Jan Jan
10| 05-Jan Jan
11 06-Jan Jan
12 07-Jan Jan
13 08-Jan Jan
14 09-Jan Jan
1R AN lan lan

ﬂ Ctrl+Space and Shift+Space
E Ctrl+Shift and Ctrl+Space

Page Layout

Formulas Data Review View »]]
AN = g D =} Wrap Text
H-A- EE B IEIE S Merge & Center
] Alignment
£ 699
D E | F G
892 984 554 2430
900 979 1056 2935
991 1039 801 283
B26 553 607 1986
1801__639] 785 3285
889 591 519 1999
508 1172 178 1858
1303 1135 580 3018
£20 £74 F7a 4c0n

B Ctrl+Shift+Space and Ctrl+Space
B) ctri+a and Ctri+Shift+a

I3 study the image below. Which of the following actions will allow you to exit
the Backstage View and continue working in the actual workbook?

(2] Microsolt Excel - Budgetatsr

i save
i seean
| Open
o Cloze

a
il T

Protect
Recent

New
s 2]

Check for

Save & Send sves>

2] options

Manage
Vessionz ~

ﬂ Pressing the Home tab.
[& Pressing the Close button.

Woribook *

. Review L

Information about Budget
GAG. Formulas and Funcliom'\Budget ddua

Permissions
Anyone can open, copy, and change any pan of this workbook.

Prepare for Sharing

Before sharmg this file, be sware that & contains:
Document properties, printer path, author's name and relate
Content that people with disabilities find difficult 1o 1esd

Versiens
3} There are no previous versons of this file,

E Pressing the Exit button.

2] Al of the above options are correct.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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Study the image of a sample worksheet below this question. Which view type
does this represent?

Workbook Views Show Zoam Wi
E9 v £
- A B € D E F G H
1
2 Nage, ,  city D
3 Sagar dg &= | Brisbane
4 Shaun Mumbai
5 Andrew Pune
6 Priyanka Sydne
7

ﬂ The Normal View E The Page Layout
The Page break View B The Zoom View

D Wd9-c-"UEs

Home Insert Page Layout Formulas Data Review View L
a w — | :
\ % Calibri 11 AN == \-. D =) Wrap Text
J -i:’ = L
—-— ¥ BIZIU- - H-A- EE= IEFE SdMegeacente
Clipboard & Font M Alignment

Which action did you not perform if the Paste button is greyed out and you
cannot press it - as pictured in the image above?

ﬂ It is not possible to copy and paste the numbers or text you wish to perform this function for.
B You have not selected the cells where you wish to paste the content.

You have selected too many cells to copy and paste and need to select one cell at a time.
E You have not copied anything or you have pressed the Escape key before pasting.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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5
2 Jack Smith 58 I I
3 Rinalowan 37
4 Louise Rank 94
5 Charlotte Drew 48
6 Caitlynn Marsh 90
7 Laura Budden 63
8 Percival Craig 75

Study the screenshot above. Which of the following functions, when inserted
in the highlighted cell (C2) above, will return the word “yes” ?

“ =IF(B2>50,"yes") E =IF(C2="yes")
=IF(B2=C2, “yes") ) =1r(B2=50, “yes”)

I study the area circled in orange in the image below. This is a page number
that was inserted using the page number buttons in the Design tab in the
Page Layout View. Which of the following represents what this text will look
like when printed?

|!|| LRE ELNE LR L R LR LR LR L LR LR L LT LR
A B C D E

&[Page] of &[Pages]

Footer

ﬂ &[Page] of &[Pages] E Page 1 E 1of2 E Page 1 of 2 Pages

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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m Study the image of a sample worksheet below this question. If you wanted
to navigate to the cell reference G29, which of the following methods could

you use?
Home | Insent  Pagelayout  Formulas  Dats  Redew  View  Developer
“ & Calbri BTRRIR = - [fj Conditions Formatting = Jlnset = E - ,\r .ﬂ
~ - B I U- AN EFEWE- FP-% o0 GHromatasTables Podete - 3- &
T me A = G Cell Stytes ~ EFormat~ 2~ ::l:’& ;::ch-
Clipboard 7 Font Angnment | Number Styles Celis Edting
89 - J= | Beacon Whippy ?

A B c D E ¥ G E
: My Candy Shop Sales
2
3 Source: Item: Cost Price: Selling Price:  Number Sold: Sales: Profit:
4 Bakery Peanut Clusters R0.20 RO.50 55 R27.50 R16.50
S Bakery Chocolate Raisins RS5.50 R10.80 2 R21.60 R10.60
6 Bakery Fudge Squares R150 R3.50 189 R661.50 R378.00
7 Bakery ChocSquares R150 R3.50 155 R542.50 R 310.00
8 Mucro  Doritos Sweet Chili R7.20 R12.20 48 R 585.60 R 240.00
9 Mucro  Beacon Whippy R2.20 R5.20 k- R 130.00 R75.00
10 Bakery  Cup Cakes R1.00 R2.50 25 R587.50 R352.50
11 Bakery Leamingtons R 100 R1.50 40 R 76.00 R36.00
12 Mucro  Cashew Nuts R10.50 R24.50 17 R416.50 R 238.00
13 Mucro  Apricot Sweets RO.10 R1.00 29 R 239.00 R215.10
14 Mucro  Funny Faces RO.10 R1.00 320 R 320.00 R 288.00
15 Bakery  Marzipan chocolate R10.50 R21.50 19 R408.50 R 209.00
16 Mucro  Liquorice R250 R8.50 189 R 1,606.50 R1,134.00
17 Mucro  Jelly Babies R2.00 R5.00 202 R 1,010.00 R 606.00
18 Mucro  Jelly Beans R2.00 R5.00 206 R 1,030.00 R 618.00
19 Mucro  Chappies RO.02 RO.25 689 R172.25 R158.47
MO M bsnms b Chantas CEN.E LYY - FETY DTIE 0. nans d
M 4 » ¥ Sheet]l /Sheet? ~Sheetd 93 A n ;‘T
Resdy | () ) 100% (=) g B

Use the Control key together with the scrolling wheel on your mouse to scroll down to cell G29.

E Use the down arrow direction key on the keyboard, holding it down or pressing it repeatedly to
get to cell G29.

E Use the vertical scroll bar on the right-hand side of the screen to scroll down so that you may
view and select cell G29.

E All of the above are correct.

For correct keyboarding, what is the recommended placement of fingers on
the home row keys?

ﬂ fingers of the left hand on A-S-D-F and fingers on the right hand on J-K-L-;
E fingers of the right hand on A-S-D-F and fingers on the left hand on J-K-L-;
E fingers of the left hand on A-S-E-F and fingers on the right hand on J-K-O-P

E fingers of the left hand on Q-W-E-R and fingers on the right hand on U-I-O-P

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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0 nie rage.l 4 view [~]

Aa B | By = | *é, o2 Width: -Automatic = Gridlines  Headings
l L= b = ;
el [ = 1=) — il ) | Em= 71 Height: Automatic = (¥ view 7 view
hemes .  Marging Onentation Sze  Punt Breaks Backgrouna Print —
- [ . . . Ares . Tes | =N Scale 100% © Print Print
9 - 5 1358

A B C D E F (
13
14 $1,600.00
15 $1,400.00

$1,200.00

18 $1,000.00 ‘

=S o | M1 ||' ihi
Study the screenshot above. Raoul was busy working on a chart in Excel
using design, layout and format options that he found on the Ribbon under
separate similarly-named tabs. However, these tabs have now disappeared
and he cannot find the options again. What can Raoul do?

u He needs to click on the chart for the tabs to reappear.

B He needs to exit the worksheet and go back in again.

E He needs to click on the Insert tab to access these options.

E He needs to click on the Home tab to access these options.

m Paf“ J Format Painter Bj7u- 0O - A EESE FF =
Chpboard . Font “ Allgnment
B2 - | PARADOX RULES
A | B | € D E F
1] Ticket Price Ticket Label
2 |25 PARADOX RULES
3 925 1

Study the example above. How can you activate and use the Autofill option to
copy the contents of cell B2 down to B50?

Select cells B2 to B50, right click and select Autofill.

Drag the Autofill Handle located at the bottom right-hand corner of the selected cell down to
cell B50.

E Go to File and select Options — Advanced Options. Go to the General section and select the
AutoFill Options button to create this fill.

E Autofill can only be used to create series or sequences. You cannot use it to copy data.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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The Fill Handle located at the bottom right-hand corner of a selected cell has
multiple uses. Which of the following is NOT a function of the Fill Handle?

D4 - £ =SUM(B4,C4)

A B C D E
1 Project Unit Cost Labour Total
| 2 78.5 $52.00 $18.00  $70.00
| 3 92.3 $103.00 $63.00 $166.00
. 4 22.1 $25.00 $8.00 $33.00
5 565 $36.00 $2.00 $38.00

|

u Copy a formula from one cell into cells adjacent to it.

E Copy formatting from one cell into cells adjacent to it.

E Enlarge the section of a table containing values.

E Automatically fill sequences such as days of the week, months or numerical values.

m A B C D

1 Expense Sheet
2 Jun-15
3
r
4 1”7 HREF!
5 2 HREF!
6 3”7 HREF!

Study the screenshot above. Miley copied values from a different worksheet
and pasted it into column B of her expense sheet. However, when she pastes
it, the above errors appears. What is happening and how can she fix it?

I She used Relative References instead of Absolute References in her formulas. If she changes
to Absolute references the problem will be resolved.

E She copied and pasted the incorrect cells. To prevent errors in copying and pasting cell
values, she should use the Fill Handle.

E She copied cell formulas instead of values. She should copy and paste the cells again and
select Paste Values from the Paste Menu.

2] She used Absolute References instead of Relative References in her formulas. If she changes
to Relative references the problem will be resolved.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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A client emails you and informs you that they were unable to open a workbook
you sent them as they still use MS Excel 2003. Which of the following options
will quickly resolve this issue and allow the client to open the workbook?

u They will need to install MS Excel 2010 or use someone else's software in order to open the
workbook.

E You can use the Save As function to select a Save As Type: Excel 97-2003 Workbook.

E If you open the workbook, you can go to the client and copy and paste all the content into
their version of Excel.

E If you rename your workbook: "Excel 2003", this will allow the client to open the file.

) which of the following statements about the Print Preview is true?

ﬂ It allows you to view what your document will look like before you physically print the pages.
E You access the Print Preview area of the Backstage View by pressing: Control + P.

E You access the Print Preview area by clicking on the File button to go to the Backstage View
and then on the Print button.

2] Al of the above statements are correct.

Slides:

| Full Page Slides

it 1 slide per page

| |
el

Full Page Slides Notes Pages Qutline

Study the screenshot above. Where will you find these options. Specifically
the option circled in red?

ﬂ Under the View tab on the Ribbon in the Presentation Views group.
I} in the Backstage View in the Print Panel.

[ 1n the PowerPoint Options dialogue box.

E In the Outline Panel in the Normal Slides View.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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Study the screenshot above. Which view type do you think this is and what is
it most useful for?

ﬂ It is called the Outline View and is perfect for viewing all the slides in a presentation.
E It is called the Slide View and is perfect for reorganizing slides in a presentation.

E It is called the Slide Sorter and is perfect for reorganizing slides in a presentation.
E It is called the Slide Master and is perfect for viewing all the slides in a presentation.

N0 s ST —— =
== - °
i - -

| W Appreciate the little things...

Live in the moment. Appreciate what is happening
- t right now. Appreciate the taste of a cup of coffee, the
smell of flowers, your ability to work, having enough
to eat etc. Stop worrying about what is wrong or
S—_— worse, what could go wrong, Itis just life. Think
about it, in 50 years time you will probably be dead.
In 150 years time no one will know you existed.
Sobering thought? So stop worrying about things you

S : r.‘:n:not change and appreciate the positives in your ‘

I 3 e

Study the screenshot above. Charles leaned over his laptop to answer the
telephone and now all the buttons on the Ribbon has disappeared although
the tab names are still visible. What happened and what is the solution?

ﬂ He has deleted the Ribbon. He needs to close PowerPoint and re-open the program.

E} The slide view is set to Zoom. He needs to zoom out of the slide in order to get the Ribbon
back.

F& The Ribbon is minimized. He needs to right-click the tabs still visible and click on: Minimize
the Ribbon, to deselect it.

E The Ribbon is disabled. He needs to click on File, launch Options and find the Display Ribbon
function.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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THEORY, |
INTERNA
1:1 ORGANIZ

* Reali

I
I
f
7-1-8-1-9-1

Study the screenshot above. To insert a copied slide between the current
slides 1 and 2, where must you position your cursor before pressing the Paste
button?

ﬂ Select Slide 1 and then press Paste. This will make the pasted slide the new Slide 2 in the
presentation.

5] select Slide 2 and then press Paste. This will make the pasted slide the new Slide 2 in the
presentation.

E Position your cursor between the current Slide 1 and 2 before pressing Paste.

E All of the options listed above are incorrect.

Peter is doing a report back on his trip to Belfast in Ireland and want to add
some reminders for himself on what to say when each photo is displayed.
How can he do this?

I He can add textboxes and titles to each slide to remind him.

E He can add text reminders to each photo slide in the Notes panel below the slide.

E He can use the Outline function in PowerPoint to create an outline for his talk.

E He can write separate notes for himself using pen and paper and use it during the talk.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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=l Colors =

| L 4 Background Styles ~
[Alfronts -

p = [0 !Eﬂec‘ls = Hide Background Graphics

Bult-In
2131 S| @ @ (3 ( 33
Office »d}a\enc) Angles Apex
»-pothe\.ar Aspect Austin Black Tie

Study the screenshot above. What is the purpose of the Effects button
(circled in yellow) in the Themes group?

ﬂ The Effects button, when pressed, offers animation effects for elements on the current slide.

E The Effects button, when pressed, offers built in formatting effects for graphical element
such as smart art, shapes and graphs.

ﬂ The Effects button, when pressed, offers collections of shapes in different colors to choose
from and insert in your slides.

E None of the above options are correct.

Study the screenshot below. What is the purpose of the green handle circled
in yellow?

7 Steps to Success

u Click this handle to resize the image by increasing its width.
5} Click this handle to rotate the image.
[ click this handle to move the image.
E Click this handle to resize the image by increasing its height.

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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Study the screenshot above. Casey selected the Angles theme from the
Themes Gallery. Is it possible for her to change the theme's color from orange
and blue to green?

u Yes, by clicking on the Colors button in the Themes group under the Design tab, she can
select a green color scheme.

E Yes, by clicking on the Background Styles button in the Background group under the Design
tab, she can select a green background.

No, the color scheme is built into the theme and cannot be changed. She will heed to
change the theme to a green theme.

E Yes, by clicking on the different parts of the background to select it and change the color of
each to green.

In the URL http://www.catscontests.org, which part is the protocol name?

I http B R I o9 5] catscontests

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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CZE Which of the following is/are the advantages of bus topology?

ﬂ Less expensive than a star topology due to less footage of cabling and no network hubs
E Good for smaller networks not requiring higher speeds

Difficult to troubleshoot fault at individual station

E All of the above

XD consider the following two statements:

Statement A: Universal Serial Bus (USB) drive is a serial bus standard based interface.

Statement B: USB does not require any expansion card to connect any peripheral to the
computer.

Which of the following is correct with respect to the above statements?

I\ statement A is correct.

5] statement B is correct.

E Statement A and B both are correct.

E Neither statement A nor statement B is correct.

(CELD 1n html, how can you justify a paragraph in your web page?

i o ]

| C 6 8 s 406 OB~ BO® |

Information and Communication - What is ‘Spam’?

O The act of overloading an e-mail server by using denial-of-
service attacks.

O E-mail messages that are infected with viruses.

O A large quantity of messages that do not reach the
recipient.

O Unsolicited direct advertising sent to a large number of

recipients.

ﬂ P="justify’ B Align="justify" P align="justified' E P align="justify"

ICATS IT Contest 2017 (Juveniles - Grade 7 & 8)
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INSTRUCTIONS

B Please recheck your Name, Father Name, Grade and School written below, the same would appear at your certificate.

This is a generic answer sheet to be used by participants of all grades. Students of Grade 1-2 will fill in circles of

first 20 questions, Grade 3-4 will fill in circles of 25 questions and Grade 5-10 will fill in circles of 30 questions.

Use of lead pencil is not allowed.

B Use only Black / Blue ink to fill in the circles.
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ICATS IT CONTEST 2018
JUVENILES (GRADE 7 & 8)

TIME ALLOWED : 90 MINUTES, MAXIMUM MARKS : 90
TOTAL QUESTIONS : 30 MCQS

INSTRUCTIONS

1.

DON'T START ATTEMPTING THE PAPER UNTIL INSTRUCTED BY THE
INVIGILATORS.

INSTRUCTIONS FROM THE EXAMINATION INVIGILATOR MUST BE CARRIED
OUTPROMPTLY.

CAREFULLY RECHECK YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS
ETC AT THE BUBBLE SHEET / ANSWER SHEET.

RECORD ALL ANSWERS ON THE BUBBLE SHEET ONLY. SELECT BEST ANSWER
FROM THE FOUR GIVEN OPTIONS AND MARK ONLY ONE OPTION IN EACH
QUESTION.

USE BLUE / BLACK INK TO FILL UP THE CIRCLES FOR YOUR ANSWERS ON THE
BUBBLE SHEET. USE OF LEAD PENCILIS NOT ALLOWED.

USE OF ANY HELPING MATERIAL INCLUDING CELL PHONES AND
ELECTRONIC DEVICESIS STRICTLY PROHIBITED.

EVERY CORRECT ANSWER EARNS THREE POINTS. THERE WOULD BE
NEGATIVE MARKING. ONE POINT WOULD BE DEDUCTED FOR EVERY
INCORRECT ANSWER.

CANDIDATES MAY NOT LEAVE THE EXAMINATION ROOM UNESCORTED FOR
ANY REASON, AND THIS INCLUDES USING THE WASHROOM.

NO MATERIALS OR ELECTRONIC DEVICES SHALL BE BROUGHT INTO THE
ROOM.

. THERE ARE FIVE CATEGORIES OF THE CONTEST AS UNDER:

A TODDLERS (GRADE 1-2)
B. KIDS (GRADE3—4)

C. JUNIORS (GRADE 5—6)

D JUVENILES (GRADE 7 8)

E ADOLESCENTS (GRADE 9—10 / O-LEVELS)

. ONLY REGISTERED STUDENTS CAN PARTICIPATE IN THE CONTEST.
. NO CANDIDATE SHALL TAKE OUT OF THE HALL ANY ANSWER BOOK() OR

PART OF AN ANSWER BOOK, WHETHER USED OR UNUSED, OR OTHER
SUPPLIED MATERIAL.

. IF A PARTICIPANT DOES NOT UNDERSTAND A WORD OR PHRASE ON THE

EXAM PAPER, NEITHER EXAMINER NOR INVIGILATOR IS PERMITTED TO
ANSWER.

. FORINFORMATION ABOUT UPCOMING CONTESTS OR PROVIDING VALUABLE

FEEDBACK, PLEASE VISIT WWW.CATSCONTESTS.ORG

. ANY ACADEMIC MISCONDUCT OR MALPRACTICE MUST BE REPORTED TO

INTERNATIOAL CATS CONTESTS AT INFO@CATSCONTESTS.ORG
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Leibniz built on Pascal’s work by creating the Leibniz Wheel. This device was
capable of what kind of calculations in addition to the ones Pascal's could do?

Y subtraction [} Addition and Multiplication
Subtraction and Multiplication E Multiplication and Division

Name the four important elements of Babbage's Engine that are components
of today's computer.

The stored program technique, an input device, an output device, and memory

E Mechanical calculation equipment, human-powered mechanisms, punched cards, and an
output device.

An input device, memory, a central processing unit, and an output device

E An input device, the stored program technique, a central processing unit, and an output device.

XY CTRL + Cis the keyboard shortcut for

u Copy E Paste E Cut E None of these

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8 ‘
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m You want to copy the ‘Downloads’ and ‘Screen’ folders to save them on
another drive.
Which key should you use in combination with the mouse in order to select
both folders?

n Ctrl E Tab C Alt E Esc

m Toolbars contain icons representing commonly used commands. The same
commands can be found ...

Y Nowhere 3 1n the menus
At the bottom of the screen E On the desktop

m Fill in the blanks:

is a set of command and program. is a set of data. is a place
where files are kept. is a symbol which you view on the computer screen.
ﬂ Icon, folder, file, OS E OS, folder, icon, File
E 0S, file, folder, icon E File, OS, icon, folder

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8)
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Use the below given information to answer questions 7 and 8.

Print ®
Primter
P —— teme =P UniersaiPantingPCLE - | Bropetie
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@Al Units: Inches Zoom: 133%
) Current view
Q l () Current page 172 '
() Pages -3 ¥ 1169 4
f Subset: All pages in range ~ T
R - pages e
P — =
Page Handling
R Lopies 1 B cllate
Page Scaling: v
[C] Aisto-Rotate and Center 1654

[lchosse papersource by PDF page size

x sustem papes s2e when nesded

|7 peint te file —
|1 Pant cotor-as black TR s
[' .
Printing Tips Page Setip... Advanced Summarize Comments
| oK Cancel

In your Mathematics lesson, you created a slide presentation.
You want to change printer before you print the slide presentation.
Which option, P,Q,R or S, will allow you to do this?

A N B o [ r B s

I How many slides have been selected for printing?

A B  C ] D5

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8) ‘
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Yesterday, in your music class you saved your compositions as MP3 files.
Today, you cannot remember where you saved them.

Which is the best way to locate the files?

u Create the files again. B Ask the person next to you.
Use the Find or Search feature. E Put your hand up and ask the teacher.

31D You want to add a graphic from a file to your history assignment.

Which menu command would achieve this?

B B o ve B

Undo Typing
Repoat Typing

Copy

Pubiishing

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8)
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m Given below are the statements about formatting the text. Select the
correct statement.

1. In MS Word, formatting the text refers to changing the look of the text
and applying various styles such as bold, italic, underline, etc.

2. After creating a document, you cannot move a single word or a line or a
whole paragraph to a new location in the document.

3. Making changes and corrections in a document with a word processor is
very complex.

ulandz Eland3 2and3 EOnIyl

m The text between X and Y has been formatted differently.
What has been used at X and Y to allow this to take place?

Australia
A unique land

Australia is a continent of contrasts. Its interior is brown, burnt by the sun
and parched of water. Its plants and animals are for the most part quite
different to those of the rest of the world.

The Gold Coast is to Southport, south of It is a great place for
42 km of white sand Brisbane. It offers a families and young
beach, which runs full range of children, with lots of
from the NSW border entertainment. theme parks.

Kakadu National Park is a World Heritage Site, famous for its waterfalls,
rockpools, birdlife and vegetation. A cruise along the river takes you through
a series of gorges. The red sandstone canyon walls rise steeply up

60 metres from the cool waters of the Katherine River.

u Columns B Gutters Page breaks E Section breaks

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8)

NN




_

6 OF 16

Starting with the letter in Figure 1, and following the changes shown,
what sequence was used to complete the task?

F w u 1

Figure 1 Figure 2

N Rotate vertical, flip right, distort
Rotate horizontal, flip right, resize

Figure 3 Figure 4

E Rotate left, flip horizontal, resize
E Rotate right, flip horizontal, distort

The text in Figure 1 was reformatted to the text in Figure 2.

Australia is a continent of
contrasts. lIts interior is
brown, burnt by the sun and
parched for water.

Australia is a continent of
contrasts. lIts interior is
brown, burnt by the sun and

parched for water.

Figure 1

Spacing
Boore: (1252

|

Line spacing: At

powle 2| [

Figure 2

3ZY Which of the following was used to achieve the new formatting?

E Indentation

Left:
Right:

RINE

E Alignment: Left

|
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Lucy is writing her dissertation. She wants to know how many words she
has so far. Study the screen shot of her program window below. Which of
the following would be the quickest solution for her?

DISSERTATION - Lucy Smith

Inserting Styles in Microsoft Word

On the inserttab, the galleriesinclude tems that are designed to coordinate with the overall look of
your document, You can use these galleries to insert tables, headers, footers, lists, cover pages, and

otherdocument building blocks, When you create pictures, charts, or diagrams, they also coordinate
| with your current document look. You can easily change the formatting of selected textinthe

o document text by choosing a look for the selected text from the Quick Styles gallery on the Home

Seom1 Pagelolls | EnglshUK) | Track Cranges Of BuRas

If she right clicks on the Status Bar and select 'Word Count' it will display the number of
words in her document.

E If she clicks on Word Count on the Status Bar it will display the number of words in her
document.

If she selects her whole document and click on Word Count in the Status Bar it will display
the number of words in her document.

E If she moves the Vertical Scroll Bar down to the end of the document and then click on
Word Count in the Status Bar, it will display the number of words in her document.

You want to use an image you found on a website in a word document, what's
the first step?

ﬂ click “Save Page As” from the browser menu and then use a photo editing software to extract
the image

E Right-click on the image and select “save image as”

E Right-click on the image and select “copy image location”

2] Al of the above

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8) ‘
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Study the screenshot below. Is there a quick way for you to format the
dates in the Dates column above to display as complete written out dates,
for example, 12 December 2014 instead of 12/12/2014?

A B C D
1 Donations: Dates:
2 $50.00 12/12/2014
3 $22.21 11/02/2015
4 $5.00 24/12/2014
5 $18.00 03/01/2015
6 $136.15 26/02/2015

m Yes, by selecting the cells and in the Number group selecting Format as Date.

E No, this is not possible. The dates above are in a format not recognized by Excel and will
need to be retyped.

No, this is not possible. If dates are not entered as dates, it cannot be changed later on.

E Yes, by selecting the cells and in the Number group selecting Long Date.

What is the name of the thin, white area above the column letters that starts
with the “/x"” button (red circled) and stretches all the way to the right edge of
the screen?

(T EELT 1 - Microsoft Excel
u ol mpart Pge Lipout Famutn Oila [P— Vi
:—‘ ’:‘““ﬂ Calibr -t A T el el v et Ganesal
P v | BOE DB e A (I B SR Emegesconter | [$= % oW ) St Ta
—— = —
A B C D
1
2 $4,356 $5,674 $3,674 $13,704
3 Tuesday 53,453 57,893 58,796 $20,142
4 Wednesday $6,783 $9,870 $2,674 $19,327
5 Thursday 56,784 $5,647 57,768 $20,199
6 Friday $2,387 $8,768 $8,876 $20,031
7 Saturday $9,878 $8,796 $2,341 $21,015
Y Ribbon I} Formula bar Mini toolbar B} Fix-it bar

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8)
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Study the below given picture and answer questions 19 through 21.

(EZa@ 8%, 48 2-2-A-Z/ 8k BEQ - @

S c D E F c B
1 Signor’s Coffee Shop
2
3 ltem Description  Price Price include GST  Size Number sold Total sales
4
5 Coflee  Short black $2.50 $2.75 Small 10 $27.50
6 Coffee | Long black $3.00 $3.30 Small 5 $16.50
7 Coflee  Flat white $3.00 $3.30 Small 8 $26.40
8 Cofflee  Cappuccino $3.00 $3.30 Small 15 $49.50
9 Coflee  Cappuccino $4.00 $4.40 Large 6 $26.40
10 Coffee Latté $3.00 $3.30 Small 7 $23.10
1
12 Most sold 15 = |
v
0 |

I Which of the following describes the group of cells that are highlighted?

N A column I} A worksheet Active cells ] A range of cells

The Total sales for Short black coffee has been determined. Which formula
was used to do this?

I[N -D5*r5 I} =D5+F5 =D5-F5 ) =p5~F5

m Which formula was entered in column F to calculate Most sold?

N -vines:Fi0)  [E] =MAX(F5:F10) =COUNT(F5:F10) 3] =AVERAGE(F5:F10)

NN
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m Which of these can you insert into a Power point presentation?

Y clip art [} A sound file directly recorded
A video clip 2] Al of the above

Study the screenshot below. Which slide type or slide layout must you select
to achieve the layout represented by the content placeholders?

Click to add title
* Click to add text * Click to add text
u Select the Content with Caption option. E Select the Two Content option.
Select the Title and Content option. E Select the Parallel and Heading option.

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8)
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Study the screenshot below. What do you think is the purpose of the area
circled in yellow below?

.- @

. L B
- oo Aa A [l Aa R RS S
. oWl Bk | ewevm  eaiee Prem— . R

etes  Dens x '

| Don'tGivein.....

When you're in the middle of a really bad situation,
those words will have little meaning, because
everything you know in your bones to be true is

» ‘ telling you that giving in would be so easy to do. But
: think about it. If everyone who was in an equally bad
situation as you are in decided to just give up and
give in - where would we all be right now and what
would life be like?

It is used to add text to each slide. After you press enter, the text will appear on the slide
in the main screen.

It is used to name each slide in a presentation. For example, the slide on display above is
called: Don't give in....

& O B8

It is used to add speaker notes to each slide that the presenter will use during the
presentation to prompt and guide them.

None of the above options are correct.

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8) ‘
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Study the screenshot below. Which view type do you think this is and what is
it most useful for?

ﬂ It is called the Outline View and is perfect for viewing all the slides in a presentation.
E It is called the Slide View and is perfect for reorganizing slides in a presentation.
E It is called the Slide Sorter View and is perfect for reorganizing slides in a presentation.

E It is called the Presentation view and is perfect for reorganizing the presentation.

CXIB what are the four main tags that are used in creating web pages?

Y Html, title, body, table I} Html, head, title, body
[ Html, p, head, title ) Htmi, body, table, p

ICATS IT CONTEST 2018 (JUVENILES - GRADE 7 & 8)
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What tag is needed to create link in HTML?

u Anchor tag E Navigation tag Linkage tag E Move tag

XD 1n HTML, which one of the following is an attribute of <form> tag

Y Method B Action Both (a)&(b) ) None of these

CZED choose the correct HTML element for the largest heading:

N <head> B <ni> <h6> B) <heading>

@ Who will receive the first copy of the following email?

From saudbhoira@noyosystems.com ~
To

u saudbhoira only a@z.com
E a only =lCe  b@z.com, c@z.com
saudbhoira, d and e
E dande =/Bec  d@z.com, é@z.com
Add Reply-To
Subject
%, Attach afile
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DON'T START ATTEMPTING THE PAPER UNTILINSTRUCTED BY THE INVIGILATORS.

INSTRUCTIONS FROM THE EXAMINATION INVIGILATORS MUST BE CARRIED OUT PROMPTLY.
CAREFULLY RECHECK YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS ETC AT THE BUBBLE
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INCLUDES USING THE WASHROOM.

NO MATERIALS OR ELECTRONIC DEVICES SHALL BE BROUGHT INTO THE ROOM.
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(9 A standard computer keyboard has how many keys?

) one Gigabyte is approximately equal to:

| A 11000,000 bytes | | C 11000,000,000,000 bytes |

| B | 1000,000,000 bytes | | D | None of these |

(XD The following are the Common Trouble shooting for Computer Units, except

| A | Double check the power connections. |

| B | Check the power cords and cable connectors in your computer unit.

| C | Unseated card or loose cards could cause malfunction. |

D | Install OS

(CZY File type can be represented by

A | file name | B | file extension | | C | file identifier |




alignment is used in the newspapers, novels and magazines

(B FULL JUSTIFICATION |

m Redo feature is used to reverse the action

In Microsoft Word, which of the following represents the most accurate list of
names of tabs on the Ribbon?

|A | The Home Tab, Print Tab, Insert Tab, References Tab, Mailings Tab, Review Tab |

| B | The Home Tab, Insert Tab, Page Layout Tab, References Tab, Mailings Tab, Review Tab, View Tab |

C | The Home Tab, Insert Tab, Print Layout Tab, References Tab, Envelopes and Labels Tab,
Review Tab, View Tab

| D | The Home Tab, Insert Tab, Page Layout Tab, References Tab, Mailings Tab, Review and View Tab |




Study the image of a MS Word screen below this question. Why is part of the
ruler displayed in white whilst the rest of the ruler appears greyed out?

Greyed out area

" White area Greyed out area

'T:T;-.'J- R R SR N I SR YA IO T K T Tl EaCTer S By T (5 O T
command. Both the Themes gallery and the Quick Styles gallery provide reset commands so that you

can always restore the look of your document to the original contained in your current template, On

the Insert tab, the galleries include items that are designed to coordinate with the overall look of

|A | The 'white' and 'greyed out' section denote the current horizontal margin size of the document. |

| B | The 'white' section denotes the area of the document that is selected horizontally on the page. |

|C | The 'white' section denotes the paper size that is being used. |

D | The 'white' section denotes the area of the page that is used and therefore represents the
page height.

Study the screenshot below. Which of the following represent a group on this
section of the Ribbon?

= -
File Home Insert Design Layout References Mailings View ¥
w1 |E ABC G | F : ; b = 4 Ik Comment B mpleMakin -1 [ Ty S
z 2 3 r | | » 5 ple Markup [ & Previous
v E] &3 P a}; AT 5 E 7 v] X

: - o Matkaup + '8 Neat
Spelling & Thesaurus Word  Smuart  Transiste Langusge New lete | Prev: et Accept Heject
Giammat Count  Lookup ’ e Comment " 4 |1 Reviewang Pane - s -

Document! - Waord (Product Activation Failes

Proofing nughts Language Camments Tracking - Changes

|A | Spelling & Grammar | [B | Accept | | D| None of the above |
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Study the screenshot of a Quick Access Toolbar below. If you wanted to move
the Redo button (right-pointing arrow) to be located next to the Undo button,
which of the following actions will be successful in achieving this?

A | Click and drag the Redo button into position next to the Undo button and click “"Save” to
accept changes.

B | Click the down pointing arrow located to the right-hand side of the Quick Access Toolbar
and select “Organize the Quick Access Toolbar” from the list. This will give you a panel in
which to reorganize the buttons on the Quick Access Toolbar.

C | In the “Customize the Quick Access Toolbar” dialogue box use the “Move Up” and
“Move Down” buttons to move the Redo button in the Quick Access Toolbar to be above
(or below) the Undo button in the list.

| D | None of the above actions will be successful. |

(39 Jenny wants to print only pages 3 — 7 of a 100 page document as single sided
pages. How can she do this?

A | She needs to set her printer to the correct settings for A4 and page numbers and then
press Print in the Backstage View.

B | In the Backstage View next to the Print tab under pages, she must set the Print Custom
Range to 3—7 and print One Sided settings.

C | In the Backstage View under Word Options, she must set the Print Custom Range to 3-7
and Print One Side Only under Printer.

D | Under Print in the Backstage View, she must set 3-7 in the Copies box under Print and
ensure 1 Page Per Sheet is selected under Pages.




Study the screenshot below this question. What does the drawing pin icon
located to the right of each document name tell you?

Tutorial - Getting Started - The Backstage View.docx
Desktop\New folder\3

Tutorial - Getting Started - Understanding and Using the Ribbon.docx
C:Documents\Letters

Quiz - Getting Started - Word Basic.docx
C:Documents\3

Quiz - Getting Started - Word Basic.docx
C:New folder\ (2)\3

Tutorial - Getting Started - Understanding and Using the Ribbon.docx
C:New folder (2)\3

| A | These items are pinned to the Recent Documents list and will not move off the list. |

| B | These items are available to be pinned to the Recent Folders list. |

|C | These items have recently been unpinned from the Recent Documents list. |

| D | These items are on the Recent Documents list, but have not been pinned to the list. |

You can save a PowerPoint presentation in multiple formats depending on what
the slides will be used for. Which of the following is NOT a file format available
in PowerPoint?

| A | Saving as a shareable un-editable document: PDF (Portable Document Format). |

| B | Saving as a watchable video: Windows Media Video. |

|C | Saving as an image: jpeg, gif or png file. |

| D | As an executable list of slides in Excel: .xIs file. |
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Study the screenshot of the Go To dialogue box below this question.
What will be the result of pressing the Go To button?

Find and Replace i\@‘
| Fnd | Reglace | GoTo |
Go to what: Enter footnote number:

12

| Enter +and - to move relative to the cuent location. Example: +4 wil
move forward four items.

=

A | It will find all instances of the number 12 and allow for moving backwards and forwards
through all instances of this number.

| B | It will jump to page 12 in the document. |

|C | It will jump to the 12th footnote in the document. |

| D | It will jump to a footnote with the number 12 in it. |

Use the following information to answer questions 15 through 19.

The Ribbon in Microsoft Excel is made up of a series of tabs, each related to specific kinds of tasks that
workers do in Excel. The Home tab, shown in the following image, contains the commands that
people use the most when creating Excel documents. Having commands visible on the work surface
enables you to work quickly and efficiently. Each tab contains groups of commands related to specific
tasks or functions.

£l = (=) e B [g]  ZAlsSum ¢ A @)

ET'_: =‘.“ ," & i)ﬁ LN TFm- z¥ M

s %3 % Conditions] Feamates Cell Insert Delete Foiimet - Son & Find &
Foemuting = | THbE=. Sty = * - - & O filles » Sebect ~
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(3B} what is the group shown in the below given image called?

ZAutoSum ~ W
2y P

(¥ Fit -
Sort & Find &
& Clear~ Filter~ Select~

| A | Font group | | B | Editing group | | C | Number group |

| DI Cells group |

((Z) What is the group shown in the below given image called?

% B [

A

Insert Delete Format

- - -

| A | Font group | | B | Editing group | | C | Number group |

|D | Cells group |

What is the group shown in the below given image called?

Calibri 11« A A

H- oA

| A | Font group | | B | Editing group | | C | Number group |

| DI Cells group |




m What is the button shown below is used for?

|A | It allows you to copy formatting from a cell or range of cells to another cell or range of cells |

| B | It allows you to copy data from a cell or range of cells to another cell or range of cells |
| C | Both of the above |

| D | None of the above |

m What is the button shown below is used for?

|A | It allows you to clear formatting from a cell or range of cells |

| B | It allows you to apply formatting to a cell or range of cells |

|C | It allows you to clear data from a cell or range of cells |

| D | None of the above |

Which of the following statements do you think is the best reason for using
PowerPoint slides during a talk?

A | Having lots of amazing pictures, video clips and graphs to show the audience is a good
reason to include PowerPoint in your talk.

B | Using PowerPoint to distract the audience from the contents of a talk, especially if the
contents is lacking in some way.

C | Being a PowerPoint expert, you use elaborate slides to impress your audience with your
slide-creation skills.

| D | None of the above reasons is a good reason to include PowerPoint slides in a talk. |
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(CZ2E) study the highlighted cells in the image below and identify which of the
following represents the correct cell address for these cells:

A D
7 Total sales 89500[
8 Costof sales 59450[
9 Gross profit 30050[
10 [
11 Overhead 5620/
12 Marketing 4500[
13 10120|
14 Net profit | 19930
15 Profit% 22|
16

|A | The cell reference for the selected cells is B:21, C:28, D:22, E:26 and F:25. |

| B | The cell reference for the selected cells is row 15, column F |

|C | The cell reference for the selected cells is F4:F5 |

| D | The cell reference for the selected cells is B15:F15 |

(22} study the image below this question. What is the purpose of the two words
circled in orange?

o

35
36
37

an
M4 4% »| Sales1 Sales2 %)

A | These represent the names of the individual workbooks you have saved. If you click on the
"Sales 2" tab it will open this workbook.

B | These reflect a selected range of cells in the worksheet. If you click on "Sales 2" it will take
you to the selected cell.

C | These represent worksheets that have been created in the workbook. If you click on them
they will take you to the different sheets.

D | This is the Name Box and represents named ranges in the worksheet. If you click on "Sales 2",
you can rename the range.
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A user wanted to create a numbered list numbered: 1 -10. When they used the
Autofill Handle it created a list of 10 number 1s (as pictured below).
What is the solution?

A

2 |
p.

Participant

| e S N o O L

I kj!ﬁ]gimim-_q!hlm-lb%w_n [

A | Insert the formula =Sum(1) in the first cell before using the Autofill handle to increment
each successive fill by 1 step.

| B | On the Home tab, go to the Editing group and click the Fill button. |

| C | Select cells A2 to A11. On the Home tab select Merge and Centre to create a numbered list. |

D | Click on the Autofill Options icon that appears just after completing an Autofill and select
'Fill Series' from the options.

m Study the formula in the cell A5 in the screenshot below. Carefully review the
cells included in the formula and the symbols included. Based on your
observations, which of the following options represent the result of this
formula?

|A | The result will be: 40 |
| B | The result will be: 22 |
| C | The result will be: 0 |

| D | The formula contains errors and will not return any result. |

0O NS W




m Study the screenshot below. In Microsoft PowerPoint, which slide type or slide
layout must you select to achieve the layout represented by the content
placeholders?

Click to add title

¢ Click to add text * Click to add text

| A | Select the Content with Caption option. |

| B | Select the Two Content option. |
| C | Select the Title and Content option. |

| D | Select the Parallel and Heading option. |

m Which of the following is NOT a method for making a duplicate of an existing
slide?

A | Using the shortcut combination: Ctrl+C to copy a selected slide and Ctrl+V to paste the
copied slide.

B | Right-click a slide and select Copy from the menu list. Press the Paste button in the
Clipboard group to paste the copied slide.

C | Using the shortcut combination: Ctrl+C to copy a selected slide and Ctrl+P to paste the
copied slide.

| D | Right-click a slide and select Duplicate Slide from the menu list. |
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iine tem Budguting

| Frngramme Gadgeting

| A | The Notes Page View |

| B | The Reading View |

Badgating Pulicy
RN Pulicy

Line Ham Badgetiog

| C | The Slide Sorter View

| D | The Presenter View |

m Study the screenshot below. How many slides does this presentation contain?

| A | One slide. |

| B | Four slides. |

| C | Nine slides. |

D | It is not possible to tell from the screenshot how
many slides the presentation contains.

4 Default Section

Sequencing Budgetary
Reforms:

Ll_as_sci!{l'si from Singapore

== =4

Type A (3 slides)
Type B (3 slides)

Type C (2 slides)




m Malware is the short form for malicious software and used to refer to

(D1 All of the above |

(CE[D To create a link to an email address syntax used is

|A | < a email="name@example.com">email</a> |

| B | <a href="mail:name@example.com">email |

| C | <email="name@example.com">email |

|D\ <a href="mailto:name@example.com">email</a> |
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ICATS English Linguistics Contest 2019
National Toppers

o [oww | 1 [weeomommenoe | won |
[ UHAMMAD WOHSIN | WanEED SHEHZAD | 1| manceRs pusLicscnooLroRsovs | uanore |
[oanoLason | wavuiw | 2 | iy eusucsoroo arusonuwon | uawore |

MUHAMMAD ASIS JAVED | MUHAMMAD SHAHEER JAVED THE CITY SCHOOL CHASHMA BRANCH MIANWALI
AYESHA SIDDIQUI M. ASHRAF UL KABIR SIDDIQUI THE CITY SCHOOL GULSHAN JUNIOR CAMPUS KARACHI

AYESHA FAISAL FAISAL EHSAN | 5 | LAHORE GRAMMAR SCHOOL LANDMARK PROJECT LAHORE

5

ASAD IMRAN | M.MRAN ] HE CITY SCHOOL CANTT CAMPUS Ii QUETTA
MANAAL TARIQ 7 HE CITY SCHOOL GIRLS CAMPUS SIALKOT
FIZZA RIZVI | auassasrizvi | 8 | nasiBGIRLs scHooL KARACHI
LAMISAH BEHRAM KHAN | BEHRAM BASHIRKHAN | 9 | LAHORE GRAMMAR SCHOOL ISLAMABAD
FAIZ UL HASSAN GILANI THE CITY SCHOOL TOWN SENIOR SECTION PESHAWAR

;I

[ AsaDimRAN | | THECTYscHooLeantrcameusit | auerra |
| MANAALTARIQ | | THECTYscHoOLGIRIscamPus | siawor |

ICATS Mathematics Contest 2019

National Toppers

Student Name
HIBA MALIK
DURYAB ZAHRA
ABDUL RASHEED
BURHANUDDIN

City

[ | ARMY PUBLICSHOOL & COLLEGE SYSTEM SADOA CAMPUS |
AU ASoHER SAMWALA | 2 | wsseoucationaLmsTore |
CwosimaL |3 | orreNce HousING AUTHONTY cOLLEGE AND SCHOOLYSTEV |
Chssaouuarauresi | 4 | rrconavwanscrooLAvD course |
Cwwamsuver | 5 | mecmvscrooLonevacampus |

Ex

A

|

s |

KN

0]

HAFIZABAD
KARACHI
KARACHI
KARACHI
MIRPUR MATHELD
FAISALABAD

EHAN QURESHI

MAHAD ABID

UROOJ AIMAL
MUHAMMAD SALAMAT
ABDULLAH JUNAID KHAN
SAAD ALI HASSAN
DANIYAL KALEEM SHEIKH
AHMED ALI

AJMAL IBRAHIM KIPS SCHOOL
SADAT MEHMOOD GARRISON ACADEMY TUFAIL SHAHEED CAMPUS (SENIOR)

ABDUL HAYEE
MUHAMMAD KALEEM
AUN ALl

LAHORE
ISLAMABAD
RAWALPINDI
RAWALPINDI
KARACHI

THE SCIENCE SCHOOL

ROOTS IVY INTERNATIONAL SCHOOL IB CAMPUS
MSB EDUCATIONAL INSTITUTE

COMPETE i you are
the BEST

www.catscontests.org




INTERNATIONAL

CATS CONTESTS

COMPETENCE & APTITUDE TESTING SERVICES

INSTRUCTIONS

m This is a generic answer sheet to be used by participants of all grades. Students of Grade 1-2 will fill in circles of
first 20 questions, Grade 3-4 will fill in circles of 25 questions and Grade 5-10 will fill in circles of 30 questions.

B Please recheck your Name, Father Name, Grade and School written below, the same would appear at your certificate.
Use of lead pencil is not allowed.

B Use only Black / Blue ink to fill in the circles.

ICATS IT Contest 2019
Grade 7-8

Q. No. Answer Q. No. Answer
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